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Présentation de CATIA

A propos de ce cours 

Présentation
CATIA est une puissante application qui vous permet de créer des conceptions riches et 
complexes. L'objectif du cours CATIA V5 Les bases est de vous apprendre à créer des pièces et 
des assemblages dans CATIA et d'en réaliser des mises en plan simples. Ce cours se concentre 
sur l'apport des connaissances et des concepts qui vous permettront de réaliser vos conceptions 
sur des bases solides.
Philosophie de conception du cours
Ce cours repose sur une approche pédagogique basée sur des processus et des tâches. Plutôt 
que d'aborder les fonctions individuelles, ce cours met l'accent sur le processus et la procédure 
permettant de mener à bien une tâche particulière. Grâce aux études de cas illustrant ces 
processus, vous allez apprendre les commandes, options et menus nécessaires à la réalisation 
des tâches de conception.

Public concerné
Le cours s'adresse aux concepteurs mécaniques, débutant dans CATIA V5.

Pré-requis
Les étudiants de ce cours doivent disposer de :

             • une expérience de la conception mécanique,

• une expérience de l'utilisation du système d'exploitation 
Windows.
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A propos du Guide étudiant

Utilisation du Guide de l'étudiant
Le Guide de l'étudiant est conçu pour être utilisé sous la direction d'un formateur certifié CATIA. Il 
contient des exemples et des études de cas qui sont conçus pour être expliqués par l'instructeur.

Exercices/Etudes de cas
Ce cours illustre l'approche par processus de deux façons : les exercices et les études de cas. 
Les exercices vous donnent la possibilité d'appliquer et de mettre en pratique les principes 
abordés lors du cours. Ils sont conçus pour vous placer dans les situations de conception et de 
modélisation habituelles. Des exercices supplémentaires ont été inclus dans ce guide pour 
répondre à la demande des étudiants souhaitant s'exercer de façon plus approfondie à la 
modélisation. Les études de cas offrent un contexte dans lequel vous pouvez utiliser des outils et 
des méthodes particuliers, et illustrent le flux de processus que vous allez utiliser dans le cadre 
d'un projet.
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Conventions utilisées dans le Guide de l'étudiant

Les conventions typographiques suivantes sont 
utilisées dans le Guide de l'étudiant :
� Le texte en gras de couleur bleue à l'intérieur d'une 

phrase souligne les options sélectionnées dans la barre de 
menu CATIA. 

� Le texte en gras de couleur marron indique les noms 
d'outil, d'icône, de bouton ou de fenêtre. 

� Le texte en italique dans les phrases sert à mettre en 
évidence des mots clés. 

� Les listes numériques sont utilisées dans les listes 
séquentielles (les étapes d'une procédure, par exemple). 

� Les sous-listes alphabétiques en minuscules sont utilisées 
dans les sous-listes séquentielles (pour les étapes d'une 
procédure d'un exercice, par exemple). 

� identifie les zones d'une image associées à des étapes dans 
une liste séquentielle (comme dans un exercice). 

� Les listes alphabétiques en majuscules sont utilisées dans 
des listes non séquentielles (une liste d'options ou de 
définitions, par exemple). 

� Le texte entre < > représente les touches du clavier sur 
lesquelles vous devez appuyer. 

� Le texte entre crochets [ ] est celui que vous devez saisir 
dans la zone de texte d'une boîte de dialogue ou d'invite de 
CATIA. 

� La disponibilité des informations, selon la configuration, est 
indiquée par le symbole suivant : 

2b

Exemple :
Procédez comme suit pour créer un nouveau 
document dans CATIA :

1. Cliquez sur Démarrer > Conception 
mécanique > Part Design.

2. Créez une pièce.
a.Cliquez sur Fichier > Nouveau.
b.Sélectionnez Product  (Produit) dans la 

boîte de dialogue New (Nouveau).
c. Cliquez sur OK.

d.Appuyez sur <CTRL> + <S> pour 
enregistrer le document.

e.Entrez [mon premier document] comme 
nom de document.

Vous pouvez créer les types de profil suivants : 
A. Contours définis par l'utilisateur
B. Contours prédéfinis
C. Cercles A

B

2b

Selon 
config.
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Etude de cas : Présentation de CATIA

Chaque leçon de ce cours comporte une étude de cas servant de support aux 
explications et concepts sur lesquels porte la leçon. L'étude de cas est décrite au 
début de chaque leçon et l'étudiant pourra réaliser l'exercice correspondant dès 
qu'il aura assimilé la théorie associée. 
Tous les modèles utilisés dans les études de cas proviennent de l'assemblage de 
la perceuse à colonne, qui constitue aussi votre projet principal. Dans cette leçon 
vous apprendrez à ouvrir et explorer les modèles dans CATIA. 

Part 
Design

Concept
ion de 
produit

Generative 
Drafting

•Exercices •Exercices •Exercices

Familiarisation

•Exercices

Projet principal(Etude de cas)
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Objectif de la conception

Chaque étude de cas contient un ensemble de 
prescriptions en matière de modèle, appelé “objectif 
de conception”. L'objectif de conception est 
présenté plus avant dans cette leçon. La première 
étude de cas ne contient pas d'objectif de 
conception car vous ne concevez rien. Toutefois, à
la fin de cette leçon, vous serez capable de :

� Modifier l'orientation d'un modèle.

� Changer les propriétés de 
visualisation d'un modèle.

� Manipuler l'arbre de spécifications.

� Accéder au système d'aide dans 
CATIA.
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Etapes du processus

Chaque leçon est constituée de plusieurs étapes. Chaque 
étape contient les informations dont vous avez besoin pour 
exécuter l'étude de cas et maintenir l'objectif de 
conception.

Dans la leçon 1 vous parcourrez les étapes suivantes pour 
vous familiariser avec CATIA :

1. Compréhension du logiciel CATIA.

2. Ouverture de CATIA.

3. Compréhension de l'interface
CATIA.
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Compréhension du logiciel CATIA
Dans cette section, vous allez découvrir PLM et dans quelle mesure il est lié à CATIA. 
Vous seront également présentées ici les fonctions clés de CATIA.

Suivez ces étapes :

1. Compréhension du
logiciel CATIA. 

2. Ouverture de CATIA.
3. Compréhension de 

l'interface CATIA.
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Définition du PLM (Product Lifecycle Management)

Le PLM (Gestion du cycle de vie du produit) est constitué d'un ensemble de normes 
auxquelles recourent les entreprises pour soutenir l'innovation dans l'étude et la fabrication de 
produits à moindre coût.

Le PLM peut être défini de la façon suivante :

Une approche stratégique qui applique une série de solutions professionnelles cohérentes à
la création collaborative, la gestion, la diffusion et l'utilisation des informations relatives à un 
produit tout au long de son cycle de vie (de sa conception à sa fin de vie) à travers toute 
l'entreprise, via l'intégration des intervenants, des processus, des systèmes de gestion et 
des informations.
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• Le PLM aplanit les obstacles technologiques qui se dressent entre les personnes qui 
conçoivent les produits et celles qui les créent, vendent, achètent et utilisent - obstacles qui 
limitent l'interaction de ces divers acteurs. 

• Grâce à la puissance des solutions collaboratives de Dassault Systèmes, les utilisateurs 
peuvent appliquer la démarche PLM à des organisations qui se lancent dans la recherche et 
le développement de produits innovants, en réduisant les temps de cycle, en rationalisant la 
fabrication et en diminuant les coûts de production.

• Voyons un exemple concret dans lequel PLM peut modifier les pratiques des innovateurs, 
fabricants et consommateurs.

Le PLM en pratique

la recherche d'un nouveau d'un nouveau modèle de vélo !
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CATIA joue un rôle important dans la solution PLM pour les fonctions suivantes :

CATIA et la solution PLM

Achat

Test
Maintenance

Analyse

Fournisseurs

Planification

Etude

Simulation
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Champ d’application de CATIA : de la conception à la réalisation

• CATIA agit comme ossature pour l'exploitation des données rassemblées au cours des divers 
processus engagés dans les étapes du cycle de vie du produit : conception, définition, 
fabrication, simulation et gestion des informations d'après-vente collectées au cours de ces 
étapes.

• Il fournit les spécifications et les données géométriques liées à un produit à travers plusieurs 
phases de cycle de vie.

���������� 	
����������� 
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Rôle de CATIA V5

CATIA est un logiciel de conception mécanique. C'est un outil de conception de modélisation 
paramétrique de solides basé sur des éléments qui tire profit de la convivialité de l'interface 
utilisateur graphique de Windows.  Vous pouvez créer des modèles de solide 3D complètement 
associatifs avec ou sans contraintes en utilisant des relations automatiques ou personnalisées 
pour comprendre l'objectif de conception. 

Pour clarifier cette définition, les termes en italique situés ci-dessus sont expliqués dans les pages 
suivantes :



Principes de base CATIA V5- Leçon 1 : Présentation de CATIA
�����������	
�����


                                                                                                                                                                                                                                                                                                                                                                            1-14

Mots clés (1/4)

Le document CATIA, comme la structure d'un 
assemblage, contient des éléments individuels 
appelés composants. 

Lors de la création d'un document, vous pouvez 
ajouter des composants tels que des extrusions, 
poches, trous, nervures, congés, chanfreins et 
dépouilles. Une fois les composants créés, ils sont 
appliqués directement à la pièce courante.

Les composants se divisent en composants issus 
d'un contour et composants d'habillage :

• Les composants issus d'un contour sont créés à
l'aide d'une esquisse 2D. En général, l'esquisse 
est transformée en un solide 3D par extrusion, 
rotation, balayage ou lissage.

• Les composants d'habillage sont créés 
directement sur le modèle solide. Les congés et 
les chanfreins font partie de ce type de 
composants.

Basés sur des composants
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Mots clés (2/4)

CATIA affiche graphiquement dans l'arbre de 
spécifications la structure basée sur les 
composants ainsi que d'autres données non 
graphiques concernant votre modèle. L'arbre de 
spécifications indique l'ordre dans lequel les 
composants ont été créés, et il vous permet 
d'accéder facilement à toutes les informations 
associées aux composants et éléments. Vous 
en apprendrez davantage sur l'arbre de 
spécifications plus loin dans cette leçon.

Orienté composants (suite)
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Mots clés (3/4)

Paramétrique

Les cotes et les relations utilisées pour la création d'un composant sont stockées dans le modèle. 
Vous pourrez ainsi comprendre l'objectif de conception et modifier aisément le modèle à partir de 
ses paramètres.
• Les cotes pilotantes sont utilisées lors de la création d'un composant. Elles contiennent les cotes 

associées à la géométrie de l'esquisse, ainsi que celles associées au composant lui-même. 
Prenons, par exemple, une extrusion cylindrique. Le diamètre de l'extrusion est défini par le 
diamètre du cercle esquissé et la hauteur de l'extrusion est définie par la profondeur d'extrusion 
appliquée au cercle.

• Les relations contiennent des informations telles que le parallélisme, la tangence et la 
concentricité. Ce type d'informations est généralement transféré aux dessins en utilisant les 
symboles de contrôle d'éléments. En saisissant ces informations dans l'esquisse, CATIA vous 
permet de saisir entièrement votre objectif de conception à son stade initial.

Modeleur de solides

Le modèle solide est le type le plus complet des modèles géométriques utilisé dans les systèmes 
CAO. Il contient toutes les géométries filaires et surfaciques permettant de décrire entièrement les 
arêtes et les faces du modèle. En plus des données géométriques, les modèles solides intègrent 
également les informations detopologie, qui relient les géométries entre elles. Par exemple, la 
topologie désigne quelles faces (surfaces) se rejoignent sur quelles arêtes (courbes). Cette 
capacité rend l'ajout de composants plus facile. Par exemple, si un modèle nécessite un congé, 
vous sélectionnerez une arête et spécifierez un rayon pour créer ce congé.
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Mots clés (4/4)

Entièrement associatif

Le modèle CATIA est entièrement associatif avec les dessins et les pièces ou assemblages 
auxquels il se rapporte. Les modifications du modèle se reflètent automatiquement sur les 
dessins, pièces et/ou assemblages qui lui sont associés. Réciproquement, toute modification 
apportée au contexte du dessin ou de l'assemblage est répercutée sur le modèle.

Contraintes

Les contraintes géométriques (telles que parallèle, perpendiculaire, horizontale, verticale, 
concentrique, coïncidence) établissent les relations entre les composants d'un modèle en 
fixant leurs positions par rapport à d'autres. De plus, vous pouvez utiliser des équations pour 
établir des relations mathématiques entre des paramètres. En recourant aux contraintes et 
aux équations, vous avez la garantie que les concepts de conception tels que les trous 
débouchants et les rayons égaux sont saisis et maintenus correctement.
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Objectif de conception (1/3)

L'objectif de conception, c'est votre plan de création du modèle solide d'une pièce, destiné à
traduire correctement ses aspects visuels et fonctionnels. Pour utiliser un programme de 
modélisation paramétrique comme CATIA de façon efficace, vous devez tenir compte de 
l'objectif de la conception avant et pendant la modélisation de la pièce. Les techniques 
utilisées pour créer le modèle ont un impact sur le comportement du modèle lorsqu'il est 
modifié au cours de son cycle de vie. 

La manière dont est conçu le modèle de solide peut affecter plusieurs aspects, notamment sa 
souplesse face aux modifications, sa stabilité lors du processus de modification et les 
exigences en matière de ressources pour calculer un nouveau résultat. Par conséquent, il est 
important de tenir compte de l'objectif de conception pour créer le meilleur modèle de solide 
de la pièce.

Les facteurs suivants contribuent à l'intégration de l'objectif de conception :
� Relations automatiques (implicites) : Selon la manière dont la géométrie est 

esquissée, les relations automatiques proposent des relations géométriques 
communes entre les objets (tangence, parallélisme, perpendicularité, horizontalité
et verticalité).

� Equations : Les équations établissent une relation entre les dimensions de façon 
mathématique. Elles fournissent un moyen externe de forcer les modifications.

� Relations supplémentaires : Les relations qui sont définies lors de la création du modèle 
permettent de se connecter à la géométrie apparentée. Certaines relations habituelles 
sont concentriques, coïncidentes et décalées.

� Dimensionnement : La manière dont une esquisse est cotée a un impact sur l'objectif de 
la conception. Vous devez ajouter des dimensions de façon à refléter la manière dont 
vous souhaitez les modifier et contrôler les éléments.
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Objectif de conception (2/3)

Les exemples suivants montrent différents objectifs de 
conception pour une même esquisse :

A. Cette esquisse est cotée pour conserver les trous à 20 
mm des arêtes de gauche et de droite, quelle que soit 
la largeur totale de la plaque (110 mm).

B. Les cotes de base fixent une position des trous par 
rapport à l'arête gauche de la plaque. Les positions des 
trous ne sont pas affectées par les modifications de la 
largeur de la plaque.

C. La cotation à partir de l'arête gauche, puis à partir du 
centre du premier trou jusqu'au centre du second trou, 
fixe la distance par rapport à l'arête gauche et entre les 
trous, quelle que soit la largeur totale de la plaque.

C

B

A
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Objectif de conception (3/3)

L'exemple ci-dessous montre une esquisse à main levée d'un plan de modelage qui donne les 
détails de l'objectif de conception complet de la pièce. Ce type de pré-planification, avant même le 
début du modelage de la pièce à l'aide de CATIA, est une stratégie excellente pour s'assurer que le 
résultat souhaité est maintenu clair et précis. 
La pré-planification vous permet d'être efficace dans la création de la conception d'un modèle 
robuste qui fournisse à la fois flexibilité et stabilité lors des modifications.
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Influence des composants sur l'objectif de conception (1/2)

Outre le choix de la méthode de cotation d'une 
esquisse, celui des composants et de la méthodologie 
de modelage affecte aussi l'objectif de conception. 
Regardez l'exemple de la révolution étape par étape 
(Résultat final) montrée ci-dessous. Vous pouvez 
créer cette pièce de plusieurs façons :

A. Approche « en couches »

• L'approche en couches crée la pièce partie 
par partie, en ajoutant une couche ou un 
élément sur l'élément précédent jusqu'à
obtention de la solution souhaitée.

• La modification de l'épaisseur ou de la forme 
d'une couche produit des effets en cascade ; 
elle change la position ou l'emplacement de 
toutes les autres couches créées ensuite.

+

+

+

+

A

Résultat final



Principes de base CATIA V5- Leçon 1 : Présentation de CATIA
�����������	
�����


                                                                                                                                                                                                                                                                                                                                                                            1-22

Influence des composants sur l'objectif de conception (2/2)

Vous pouvez créer cette pièce de plusieurs façons 
(suite) :

B. Approche « tour de potier »

• L'approche tour de potier consiste à créer 
la pièce en tant que composant unique de 
révolution. Une seule esquisse 
représentant la section croisée comporte 
toutes les informations et cotes nécessaires 
à la création de la pièce comme composant 
unique. Alors que cette approche peut 
paraître la plus efficace, le fait d'avoir 
toutes les informations de conception dans 
un composant unique limite la flexibilité et 
peut rendre les modifications difficiles.

C. Approche « fabrication »

• L'approche fabrication du modelage imite la 
façon dont la pièce peut être fabriquée. Par 
exemple, si cette révolution par étape était 
définie sur un tour, vous devriez démarrer 
avec une pièce baril et retirer de la matière 
en utilisant une série de coupes.

-

-

-

B C
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Exercice : Objectif de conception
Exercice : Récapitulatif

20 min

Dans cet exercice, vous retrouverez la description des termes clés de CATIA et 
identifierez l'objectif de conception pour différentes pièces.

A la fin de cet exercice, vous serez capable de :

� Définir les termes clés de CATIA.

� Identifier et décrire l'objectif de 
conception pour diverses pièces.
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C'est à vous !

Identifiez la définition correcte qui décrit le mieux 
les mots suivants :

----- Modeleur de solides
----- Orienté composant
----- Paramétrique
----- Contraintes
----- Objectif de conception
----- PLM

A. Eléments géométriques, tels que 
extrusions, poches, trous, nervures, 
congés, chanfreins, etc. appliqués à un 
objet de travail pour former une pièce. 

B. Modèle géométrique contenant toute la 
topologie, les élément filaires et la 
géométrie de surface nécessaires à
l'entière description des arêtes et des faces 
d'une pièce. 

C. Les cotes et les relations utilisées pour la 
création d'un composant sont saisies et 
stockées dans le modèle. 

D. Plan expliquant comment créer ou 
développer le modèle d'une pièce pour 
pouvoir transmettre les aspects visuels et 
fonctionnels de la pièce.

E. Une approche stratégique qui applique une 
série de solutions professionnelles 
cohérentes à la création collaborative, la 
gestion, la diffusion et l'utilisation des 
informations relatives à un produit tout au 
long de son cycle de vie, à travers toute 
l'entreprise.

F. Relations géométriques, telles que le 
parallélisme, la perpendicularité, 
l'horizontalité, la verticalité, la concentricité
et la coïncidence, ou équations destinées à
établir des relations mathématiques entre 
les paramètres. 
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Illustration de l'exercice

Examinez le dessin et identifiez tous les 
éléments qui doivent être reflétés dans l'objectif 
de la conception :
Plaque support

Bras de suspension

Bras de suspension

Plaque support
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Ouverture de CATIA
Dans cette section, vous apprendrez à ouvrir CATIA dans un environnement Windows.

Suivez ces étapes :

1. Compréhension du logiciel
CATIA.

2. Ouverture de CATIA.
3. Compréhension de 

l'interface CATIA.



Principes de base CATIA V5- Leçon 1 : Présentation de CATIA
�����������	
�����


                                                                                                                                                                                                                                                                                                                                                                            1-27

Démarrage de CATIA à partir du menu Démarrer

Dans un environnement Windows vous pouvez démarrer l'application CATIA de plusieurs 
façons :
A. Sélectionner CATIA à partir du menu Start > Programs > CATIA (Démarrer > 

Programmes > CATIA).
B. Cliquer deux fois sur l'icône CATIA sur le bureau Windows.
C. Cliquer deux fois sur un document CATIA existant.

C

B

A
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Ouverture d'un document existant

Suivez ces étapes pour ouvrir un document existant 
dans CATIA :

1. Sélectionnez File > Open (Fichier > Ouvrir) 
, ou cliquez sur l'icône Open (Ouvrir).

2. Naviguez jusqu'à l'emplacement du fichier à
l'aide de la liste Look in de la boîte de 
dialogue File Selection (Sélection de 
fichier).

3. Dans la liste Files of type (Type de 
fichiers) , sélectionnez le type de document 
que vous souhaitez ouvrir.

4. Cochez la case Show Preview (Afficher 
l'aperçu) pour visualiser un aperçu du fichier 
sélectionné.

5. Cliquez sur Open (Ouvrir).

1

5

4

3

2



Principes de base CATIA V5- Leçon 1 : Présentation de CATIA
�����������	
�����


                                                                                                                                                                                                                                                                                                                                                                            1-29

�

Compréhension de l'interface CATIA
Dans cette section, vous allez vous familiariser avec l'interface utilisateur de CATIA.

Suivez ces étapes :

1. Compréhension du logiciel
CATIA

2. Ouverture de CATIA
3. Compréhension de 

l'interface CATIA
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Philosophie Windows (1/4)

CATIA V5 a été spécialement conçu pour fonctionner sous le système d'exploitation Windows, et 
il se comporte comme les autres applications Windows.  

Les menus habituels permettent d'accéder à toutes les commandes CATIA. 

Certaines options de menu ont des options supplémentaires associées :

A. Une flèche pointant vers la droite indique un sous-menu.  

B. Un nom de commande suivit par une série de points 
indique que la sélection de la commande ouvrira une boîte 
de dialogue avec des options supplémentaires.

A

B
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Philosophie Windows (2/4)

Les barres d'outils sont constituées d'icônes 
permettant un accès rapide aux commandes le plus 
souvent utilisées. Les barres d'outils sont 
organisées dans les ateliers. Elles peuvent être 
personnalisées, réorganisées et repositionnées 
comme bon vous semble.

Par exemple, la barre d'outils Standard contient les 
commandes Ouvrir, Enregistrer, Imprimer, Couper, 
Annuler et Accès à l'aide en ligne.

Certaines icônes de la barre d'outils possèdent des 
icônes supplémentaires qui leur sont associées :

A. Une flèche (pointant vers le bas) en bas d'une 
icône signifie que plusieurs outils du même 
type sont disponibles.  

A
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CATIA V5 utilise une souris à trois boutons pour la sélection et l'indication de données 
d'entrée de la part de l'utilisateur.  Vous trouverez ci-dessous les fonctionnalités générales 
des boutons de la souris. Une description complète de leur utilisation sera traitée plus loin 
dans cette leçon.

Philosophie Windows (3/4)

A

B

C

A. Le bouton gauche de la souris est utilisé pour 
sélectionner les composants ou éléments affichés 
sur l'écran.

B. Le bouton du milieu (ou la molette) sert à indiquer 
ou pointer une direction sur l'écran.

C. Le bouton droit de la souris a pour fonction 
d'afficher un menu contextuel relatif aux éléments 
actuellement sélectionnés ou présélectionnés à
l'écran.
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CATIA fournit aux utilisateurs divers niveaux de retour système, notamment :

Philosophie Windows (4/4)

A. Le curseur de la souris est représenté par 
différents symboles pour indiquer les divers 
états.

B. Les messages sont affichés pour donner des 
indications sur la progression, l'échec ou le 
résultat d'une procédure.

C. Une bulle d'information (info-bulle) et un 
message d'aide s'affichent lorsque vous 
placez le curseur sur un outil particulier (sans 
le sélectionner).

C

A

B
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Présentation des documents V5

Vous pouvez créer, modifier et enregistrer différents types 
de documents dans CATIA. Ces documents contiennent 
les informations géométriques et les spécifications 
définissant un objet. Les documents les plus courants 
(présentés dans ce cours) sont :

A. Document de pièce (.CATPart).

B. Document d'assemblage (.CATProduct).

C. Document de dessin (.CATDrawing).

C

B

A
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Le concept d'atelier

Pour travailler dans un document CATIA, vous 
devez utiliser l'un des ateliers affectés au type de 
document.  Chaque atelier contient un groupe 
d'outils dédiés à la réalisation d'une tâche 
spécifique. Voici une liste des ateliers les plus 
fréquemment utilisés :

Icône de l'atelier courant 

Documents

• Part Design : Pour la conception de 
pièces par modélisation du solide

• Sketcher : Pour la création de contours 
2D avec contraintes associées, qui 
pourront servir à la création d'une 
géométrie 3D.

• Conception filaire et surfacique : 
Pour la création de pièces complexes avec 
des éléments filaires et surfaciques 3D.

• Assembly Design : Pour la création de 
contraintes, de composants et de 
spécifications pour des pièces dans le 
cadre d'un assemblage.

• Generative and Interactive Drafting : 
Pour la création de dessins à partir de 
pièces et d'assemblages.
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Interface utilisateur CATIA (1/2)

L'interface utilisation CATIA adopte l'interface Windows 
et s'appuie sur les principes suivants.

• Ateliers distincts, avec leurs barres d'outils 
respectives.

• Navigation facile d'un atelier à un autre.

• Menus et barres de menu standard et 
spécifiques (Fichier, Edition, Insertion...)

• Manipulations standard (Copier-Coller, Glisser-
Déposer, Edition…) .

• Manipulations intuitives (Mise en surbrillance, 
copilote, formes de pointeur...).

• Prise en charge de multiples documents.

• Prise en charge de menu contextuel (bouton 
droit de la souris).

• Arbre de spécifications, comprenant tous les 
composants technologiques, les contraintes et 
les relations.
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Interface utilisateur CATIA (2/2)

Vous trouverez ci-dessous une présentation des 
éléments de l'application CATIA standard :

A. Commandes de menu.

B. Arbre de spécifications.

C. Fenêtre de document actif.

D. Nom de fichier et extension de document 
courant.

E. Icônes pour agrandir, réduire et fermer la 
fenêtre.

F. Icône de l'atelier en cours.

G. Barres d'outils spécifiques à l'atelier en cours.

H. Barre d'outils standard.

I. Boussole

J. Zone de la géométrie.

A

B

C
D E

F

G

H

I

J
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Les ateliers contiennent les différents outils dont 
vous pouvez avoir besoin pendant la création de 
votre pièce. Vous pouvez passer d'un atelier 
principal à un autre en utilisant l'une des deux 
méthodes suivantes :

Ateliers

A. Utiliser le menu Start (Démarrer) pour 
ouvrir l'atelier requis.

B. Cliquer sur File > New (Fichier > 
Nouveau) pour créer un nouveau 
document de type fichier particulier. 
L'atelier associé s'ouvre 
automatiquement.

B

A
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Les barres d'outils fournissent un accès rapide aux outils qui sont également 
disponibles à partir des menus. Suivez ces étapes pour activer/désactiver une barre 
d'outils :

Menus et barres d'outils (1/2)

1. Cliquez sur le menu View > Toolbars
(Affichage > Barres d'outils).

2. Une liste des barres d'outils en rapport avec 
l'atelier courant s'affiche. 

3. Les barres d'outils activées sont cochées.

4. Sélectionnez la barre d'outils à activer ou 
désactiver. 

1

2
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Menus et barres d'outils (2/2)

Vous pouvez ensuite manoeuvrer les barres d'outils pour 
les fermer, les réorganiser ou les afficher :

A. Cliquez sur Fermer pour désactiver une 
barre d'outils flottante.

B. Réorganisez les barres d'outils en faisant 
glisser le séparateur de l'une d'elles vers 
l'emplacement voulu sur l'écran. 

C. Un symbole de double flèche (>>) dans 
l'angle de la zone de la barre d'outils indique 
qu'il n'y a plus d'outils disponibles et qu'ils ne 
sont pas visibles du fait de la taille de la 
fenêtre. Faites glisser le symbole dans la 
zone d'affichage de la géométrie afin de 
visualiser les outils.

B

C

A
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Trouver les outils

Etant donné le nombre d'outils et de barre d'outils 
contenus dans CATIA, il n'est pas possible de les 
afficher tous dans la fenêtre. CATIA gère ce 
problème d'affichage à l'aide de barres d'outils 
rétractables et empilables supplémentaires sur les 
bords de la fenêtre.

Si vous n'arrivez pas à trouver une barre d'outils ou 
un outil, vérifiez que :

A. L'outil que vous cherchez n'est pas localisé
comme outil facultatif « sorti de l'espace ». 
CATIA regroupe les variantes du même outil 
dans un même groupe d'affichage qui est 
accessible en cliquant sur la flèche noire.

B. L'outil / la barre d'outils n'est pas hors de 
l'écran. Cherchez les symboles >> dans les 
angles de la fenêtre. Vous pouvez faire 
glisser la barre d'outils vers l'extérieur afin de 
visualiser tous les outils.

C. La barre d'outils est activée.

C

A

B
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Arbre des spécifications

CATIA V5 fournit un arbre de spécifications, qui 
conserve la hiérarchie des composants, les 
contraintes, les processus et les informations sur les 
assemblages pour un document CATIA. L'arbre de 
spécifications fournit un enregistrement visuel étape 
par étape de l'ordre suivi lors de la création d'un 
modèle solide.

Vous pouvez modifier, réorganiser ou déplacer les 
étapes dans le processus et les spécifications de 
conception pour réaliser une nouvelle pièce finie sans 
avoir à recréer le modèle. 

L'arbre des spécifications peut faire disparaître 
certains composants et informations en les retirant 
temporairement du modèle.

Par exemple, le modèle ci-contre contient plusieurs 
composants trous. Vous pouvez tout simplement 
désactiver (effacer) les trous et laisser le modèle 
refléter la zone de base sans avoir à supprimer 
réellement les trous. 
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Manipulation de l'arbre de spécifications

CATIA vous permet de manipuler l'arbre de spécifications comme la zone géométrique.
Pour plus d'informations, reportez-vous à la liste ci-dessous :

Manipulation Action Description

Cacher
l'arborescence

Appuyez sur le bouton <F3> pour 
cacher ou afficher l'arborescence.

Activer / Désactiver
l'arborescence

Cliquez n'importe où dans la structure de 
l'arborescence ou cliquez sur <Maj> et 
<F3> simultanément pour activer ou 
désactiver l'arborescence.

Ou
Maj+

Déplacer
l'arborescence

Faire glisser et déposer la structure de 
l'arborescence avec le bouton gauche de 
la souris.

Développer / réduire 
un noeud de 
l'arborescence.

Cliquer sur le signe [+] pour développer le 
noeud et sur le signe [–] pour le réduire.
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Sélection d'objets avec la souris

CATIA, comme toutes les autres applications 
d'environnement Windows, présente une 
interface à manipuler principalement avec la 
souris. Quand vous travaillez avec CATIA, il y a 
deux façons de sélectionner les objets : 

A. Sélection simple 
• Pour sélectionner un objet, appuyez sur le 

bouton gauche de la souris.
• Vous pouvez sélectionner un objet 

directement à partir du modèle ou de son 
composant dans l'arborescence. La 
sélection de géométrie met en surbrillance 
le composant dans l'arborescence et vice-
versa.

B. Sélection de plusieurs objets
• Pour sélectionner plusieurs objets, 

maintenez appuyée la touche <Ctrl> en 
utilisant le bouton gauche de la souris pour 
sélectionner les objets.

• La multi-sélection peut aussi être exécutée 
en « attirant » les objets dans une zone de 
sélection.

+

+

B

A
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Les approches Objet/Action et Action/Objet

CATIA est différent des autres applications Windows. Vous pouvez contrôler l'ordre de 
sélection des éléments et des outils. Vous pouvez :

A. Sélectionner d'abord le ou les objets à traiter, puis l'outil requis pour l'exécution de l'opération.
B. Ou sélectionner d'abord l'outil requis pour l'exécution de l'opération, puis le ou les objets à

traiter.

A B
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Utilisation des boîtes de dialogue CATIA (1/2)

Les boîtes de dialogue CATIA fournissent divers paramètres servant à la définition des 
composants. Elles sont normalisées et faciles à utiliser pour définir les données d'entrée pour un 
composant ou un processus. Par exemple, la boîte de dialogue de définition de trou est présentée 
ci-dessous. 

Voici une liste des éléments courants que vous pouvez trouver dans une boîte de dialogue CATIA :
A. Nom de la boîte de dialogue

B. Onglets regroupant des types de 
paramètres similaires

C. Boîte à liste déroulante pour diverses 
options

D. Boîte d'incrément servant à augmenter ou 
réduire la valeur des données d'entrée

E. Champs verrouillés pour protéger les 
données

F. Boutons d'icônes pour activer d'autres 
actions

A

B

C

D

E

F
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Utilisation des boîtes de dialogue CATIA (2/2)

Voici la liste des éléments courants que vous pouvez trouver dans une fenêtre (suite) :

G. Cases à cocher pour activer les options

H. Champs inactifs pour un cas particulier

I. Bouton OK pour confirmer l'action

J. Bouton Cancel (Annuler) pour quitter la 
commande

K. Bouton Preview (Aperçu) pour prévisualiser le 
résultat

L. Aide pour la boîte de dialogue

M. Bouton Close (Fermer) pour fermer la boîte de 
dialogue

N. Assistants visuels qui affichent le résultat 
des options sélectionnées

G
H

I J K

L M

N
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Utilisation des boîtes de dialogue et du clic droit

Vous pouvez également entrer des données dans certaines zones d'une boîte de dialogue 
en cliquant avec le bouton droit de la souris (clic droit) sur ces zones. Les options qui 
apparaissent dans le menu contextuel sont adaptées au type des données qui peuvent 
être entrées dans cette zone.



Principes de base CATIA V5- Leçon 1 : Présentation de CATIA
�����������	
�����


                                                                                                                                                                                                                                                                                                                                                                            1-49

Déplacement d'objets avec la souris (1/2)

Puisque CATIA est un environnement 3D, 
vous pouvez voir le modèle de différentes 
façons. 

Les opérations de base pour modifier la vue 
d'un modèle sont l'agrandissement, le 
déplacement et la rotation :

pointeur

A. Vous pouvez déplacer le modèle sur un 
plan parallèle à l'écran. Pour ce faire, faites 
glisser la souris tout en cliquant et en 
maintenant  le bouton du milieu (n°2) 
enfoncé.

B. La rotation vous permet de faire pivoter le 
modèle autour d'un point. Pour ce faire, 
faites glisser la souris tout en cliquant et en 
maintenant le bouton du milieu (n°2) et le 
bouton de gauche (n°1) enfoncés.

B

A
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Déplacement d'objets avec la souris (2/2)

Les opérations de base pour modifier la vue 
d'un modèle sont l'agrandissement, le 
déplacement et la rotation (suite) :

C. Le zoomage vous permet de vous déplacer 
auprès ou loin du modèle le long d'un plan 
perpendiculaire à l'écran. Pour ce faire, 
cliquez et maintenez enfoncé le bouton du 
milieu (n°2) de la souris tout en cliquant sur 
le bouton gauche (n°1) une fois, puis faites 
glisser la souris de haut en bas pour vous 
approcher ou vous éloigner du modèle.

C
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Boussole

En plus d'être un outil performant d'orientation 
qui aide à l'exécution de rotations de vues, la 
boussole est également un outil puissant que 
vous pouvez utiliser pour déplacer et manipuler 
physiquement les objets. Cette fonction est 
particulièrement utile dans les ateliers 
Assembly Design, Freestyle et Digital Mockup. 

Par défaut, la base de la boussole (également 
appelée plan privilégié) est le plan XY.
L'orientation de la boussole par défaut est 
parallèle au système de référence XYZ. Elle se 
trouve dans l'angle supérieur droit de l'écran.

Si la vue 3D est modifiée, la boussole met à
jour son orientation pour refléter la nouvelle 
direction ou le nouvel angle de visualisation.
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Propriétés graphiques

La barre d'outils Graphic Properties (Propriétés graphiques) vous aide 
à modifier les propriétés graphiques des éléments affichés à l'écran.
Elle fournit des outils permettant de modifier les propriétés suivantes :

A B C D E F G H

A. Couleur de remplissage.

B. Transparence.

C. Epaisseur de trait.

D. Type de trait.

E. Symbole de point.

F. Style de rendu.

G. Calque actif.

H. L'outil Painter copie les propriétés 
graphiques d'un élément et les applique à
un autre. 
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Modification des propriétés graphiques

Suivez ces étapes pour modifier les propriétés graphiques d'un 
élément :

1. Sélectionnez le ou les éléments avec le 
bouton gauche de la souris. 

2. Cliquez avec le bouton droit de la souris et 
sélectionnez Properties (Propriétés) dans 
le menu contextuel.

3. Sélectionnez l'onglet Graphic (Graphique) 
et modifiez les propriétés graphiques 
requises. 

1

2

3
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Styles de rendu

CATIA a la possibilité d'appliquer différents styles 
de rendu pour visionner la géométrie et fournir une 
vision plus claire du modèle. La barre d'outils View
(Affichage) contient les styles de rendu suivants :

A. Réaliste

B. Réaliste avec arêtes

C. Réaliste avec arêtes sans arêtes mortes

D. Réaliste avec arêtes et arêtes cachées

E. Réaliste avec texture

F. Filaire
F

B

A

D

C

E

A B C D E F
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Application de styles de rendu

Suivez ces étapes pour appliquer un style :

1. Sélectionnez l'icône de style de rendu dans 
la barre d'outils View (Affichage). 

2. Sélectionnez le nouveau style de rendu à
appliquer. Il est appliqué automatiquement 
à la géométrie.

1

2
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Companion CATIA

CATIA contient plus d'un assistant destiné à vous 
aider à approfondir les détails de tous les outils et 
fonctions. L'un de ces outils se trouvant au centre 
de votre environnement de travail pour 
l'apprentissage de Catia est User Companion. 

Companion est constitué de séries intégrées 
d'objets pédagogiques, dans le but de vous 
permettre d'apprendre à votre propre rythme, 
d'acquérir des connaissances supplémentaires ou 
d'effectuer des exercices pratiques additionnels 
sur les sujets suivants :

� CATIA V5 (Conception mécanique, 
Conception hybride, Generative Sheet
Metal Design, Analyse) 

� DMU
� ENOVIA
� SMARTEAM
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Aide

L'outil fournissant les informations est la 
documentation d'aide en ligne.

Le système d'aide est constitué d'une série de 
documents HTML indépendants, fournissant les 
informations CATIA sur les ateliers, les produits 
et les solutions. 
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Barre de message

Vous avez à votre disposition un autre outil qui 
vous fournit les éléments nécessaires à
l'exécution d'une commande : la barre de 
Message. 

Lors de la sélection d'un outil, CATIA vous 
indique, par le biais de la barre de message, les 
données particulières qui sont nécessaires à
l'exécution d'une commande.  




